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SONAR 2015  

“Ipswich” Update 
 

We have a jam-packed eZine issue for you 

this month, and the SONAR updates to go 

with it. The big Ipswich news is real-time, 

direct recording of instrument tracks, but 

that’s not all. Exporting just became a whole 

lot easier thanks to export presets and the ability to export multiple, individual clips 

simultaneously. Ipswich also sees the addition of MixStrips and Style Dials to SONAR Artist, as 

well as ProChannel versions of the Style Dials for SONAR Professional and Platinum. There’s 

even PNG support for track icons, and as usual, fixes and enhancements to make the SONAR 

environment ever more stable. We’re also introducing two new, semi-regular eZine features: 

“Anatomy of a Project” that showcases real-world SONAR applications, and “BlogBeat” to point 

to some of the Cakewalk blog’s “greatest hits.” The weather outside may be turning colder, but 

SONAR keeps getting hotter. Thanks for your support! – Bill Jackson and the Cakewalk Team 

 

Direct Synth Recording: Record synth outputs as audio in real time—this can be 

simpler than bouncing, and has numerous applications. Record improvisational 

gestures that can’t be recording as automation, “future-proof” virtual instruments 

parts with easy audio backup, capture randomized sounds, and more. 

 

Virtual Instrument “Smart Mute” Disable: This goes hand-in-hand with Direct 

Synth Recording. When enabled, SONAR’s “Smart Mute” mode for virtual 

instruments automatically mutes both the synth audio and MIDI tracks if either is 

muted. However, you can now disable this when doing Direct Synth Recording. 

 

ProChannel “Style Dials”: They’ve been a big hit in Music Creator 7, so we thought 

it was about time Style Dials became available as ProChannel modules for SONAR 

Professional and Platinum. The three modules—Grit, Max, and Space—do pretty 

much what you’d expect from the names.  

 

MixStrip Integration: The MixStrips in Music Creator 7 are like a baby ProChannel, 

and have become a very popular feature. So, we’ve figured out how to integrate 

MixStrips into SONAR Artist to give even more value in our least expensive version. 

And to top it off, we’re including three Style Dial plug-ins. 
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Export and Bounce Presets: Previously you could create and save your favorite 

parameter presets for both exporting and bouncing, and take advantage of several 

included presets. However starting with Ipswich, the settings in the export and 

bounce dialogs now persist in projects and templates. 

  

PNG Support for Track Icons: The PNG (Portable Network Graphics) file format for 

graphics is much more advanced than the .BMP format. Now you can create, save, 

and import really great-looking track icons that include transparency so they can 

blend in with colors and backgrounds. 

 

Multiple Clip Export: When exporting audio, in addition to exporting specific 

tracks, buses, outputs, or the entire mix, you can now export multiple clips 

simultaneously. Choose “Clips” under Bounce Settings to export each clip 

individually into a folder or other location, and give the file names a prefix.  

 

Clip Export with Extended “Tail”: When exporting clips, SONAR traditionally 

exported only the audio defined within the clip itself. For example if there was 

delay or reverb, the “tail” would stop when the clip ended. Starting with Ipswich, 

now you can specify a time to accommodate a clip’s tail when exporting. 

 

Workflow Enhancements and Fixes: This update offers multiple fixes, including 

some intermittent ones that were difficult to track down (like the occasional icon 

corruption upon opening a project). Among others there’s another Staff View fix, 

Start Screen improvements, and more accurate AudioSnap transient detection. 

 

Anatomy of a SONAR Project—Loop-Based Video Soundtrack: This article 

describes some of the artistic and technical decisions, as well as the techniques, 

when using SONAR and its included content to create an instrumental soundtrack 

under tight deadlines for a product video. 

 

Review |Ploytec PL2 Miniature Hardware Synthesizer: It’s slightly larger than an 

ice cube, but it’s a true hardware synthesizer with zero latency and sounds that 

are, shall we say, not exactly strings, French horns, and pianos. It’s compatible with 

SONAR’s virtual keyboard, and even offers a multi-client MIDI driver. 

 

BlogBeat: A roundup of a few of the Cakewalk Blog’s “greatest hits.” Get that 

“analog sound” in SONAR, avoid common mixing mistakes, learn what iLan 

Bluestone does to help him top the EDM charts, discover tips to maximize SONAR’s 

efficiency for songwriters, and create more dynamic vocals. 
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How to Download Ipswich 
 

Open the Cakewalk Command Center. Please note that Cakewalk Command Center version 

1.1.2 is now available, so download it if you haven’t already. There are two major changes: 

 

 The default time interval for checking for updates is now 0. This is because when the 

default was 24 hours, users thought updates weren’t available if they’d opened the 

program less than 24 hours before the update was posted. However, you can still 

specify a default time interval to check for updates if you don’t want SONAR to check 

every time you go on line, and you can also go click on Settings and choose Check Now 

to check for updates at any time. 

 Editing the VST3 scan path from the Cakewalk Command Center has been removed. 

Unfortunately, exposing this for editing can cause issues with VST3 support. 

 

To download Ipswich itself, download from the core SONAR Artist, Professional, or Platinum 

category.  
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Direct (Real Time) Synth Recording   
Artist, Professional, Platinum 
 

Thanks to direct synth recording, bouncing is no longer necessary to convert a virtual synth 

output into audio because you can now record the synth audio in real time. The main 

advantages to real-time virtual instrument recording include: 

 

 Capture improvisational gestures that can’t be captured via automation data 

 Capture randomized synth parameters that never repeat the same way twice 

 With multi-output instruments, record all outputs as audio without having to bounce 

each one individually 

 Record MIDI and audio simultaneously 

 Record an instrument output into multiple tracks simultaneously (e.g., if you want 

different processing on each one) 

 Easy and CPU-friendly layering by recording the same part with different instrument 

presets, or even editing the MIDI data and re-recording the part 

 “Future-proof” virtual instrument parts by recording them as audio tracks  

 

SELECTING AN INSTRUMENT OUTPUT AS AN AUDIO TRACK INPUT 

 

An instrument’s outputs show up as available inputs on the Input widget for any audio track. 
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Simply select the input as you would any other available audio signal, and arm record. Also note 

this works for Console view. If a project includes multiple instruments, each has its own input 

selector to avoid clutter. 

 

 
 

Recording works the same as recording audio, including punch recording, loop recording and 

take management, and of course you can record multiple outputs simultaneously on multiple 

tracks. 

 

Finally, in Ipswich the waveform preview button is next to the record button. The waveform 

preview button always shows the post-fader waveform. The record preview is always pre-fader. 

So if you press the waveform preview button during recording, it will switch to displaying the 

post-fader waveform; switching it off will return to displaying the (pre-fader) record preview. In 

other words, there are now implicitly two different tap points available for the preview.  
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Virtual Instrument “Smart Mute” Disable   
Artist, Professional, Platinum 
 

When enabled, SONAR’s “Smart Mute” mode for virtual instruments automatically mutes both 

the synth audio and MIDI tracks if either one is muted. This is the preferred behavior with 

virtual instruments having multiple outputs, because you generally want to make sure all audio 

outputs are muted when you mute the MIDI track driving them.  

 

However, with direct synth recording there may be times when you want to mute some audio 

outputs but not others, so it’s now possible to disable smart mute in the Browser. Click the 

drop-down menu on the Synth tab to enable or disable smart mute. This is global and affects all 

synths. 
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ProChannel Style Dials   
Professional, Platinum 
 

 
 

Style Dials were introduced in Music Creator 7’s MixStrips as easy-to-use, single-knob 

controls—often controlling multiple parameters simultaneously—to speed up workflow when 

looking for a specific effect. Because they’ve proven to be surprisingly popular, it didn’t seem 

right that these weren’t available to SONAR users. 

 

So, the Style Dials have now been ported over to ProChannel versions for Professional and 

Platinum users. The names are pretty self-descriptive, but here are the basics. 

 

 Grit adds a little bit of dirt and distortion to signals. Try it on guitars, drums, and 

especially bass when you want it to stand out a bit in a mix. 

 Max is your basic “let’s squash this thing” dynamics control. It’s a great way to lift parts 

a little higher in the mix without having to increase levels. 

 Space gives some quick reverb-based ambience when you don’t want to take the time 

to mess with a plethora of reverb parameters. It makes a fine placeholder until it’s time 

to mix, when you’ll probably want to use the Breverb or REmatrix Solo. 

 

And for a peek into the future, we’re planning some more Style Dials …so stay tuned. 
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MixStrip Integration 
Artist 

 

If you’re a SONAR Artist user who’s been looking 

longingly at the ProChannel in the Professional and 

Platinum versions, this is the update for you: MixStrips, 

first included in Music Creator 7, have now been 

integrated into SONAR Artist. And to kick things off, 

you’re getting the Grit, Max, and Space Style Dials—for 

details, see the descriptions above. 

 

MixStrips add considerable value to the basic SONAR 

version, and give a taste of the ProChannel flavor. What’s 

more, any future Style Dials introduced for Music Creator 

will also be compatible with Artist’s MixStrips. 
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Export and Bounce Presets    
Artist, Professional, Platinum 

 

Previously, you could create and save your favorite parameter presets for both exporting and 

bouncing. In the Bounce to Track(s) or Export Audio dialog boxes, you simply choose the 

desired preset from the drop-down menu. 

 

 
 

However for your added convenience, the settings in the export and bounce dialogs now persist 

in projects and templates (not the presets themselves). For example, if you change the settings 

in the Export dialog and save a project after that, the next time you load that project, those 

dialog settings will be restored. This is very useful when you want to return to the last settings 

used on a per-project basis.  
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PNG Support for Track Icons    
Artist, Professional, Platinum 
 

The PNG (Portable Network Graphics) file format for graphics is the most popular lossless image 

compression format on the internet. Unlike GIF, the compression algorithm used in PNG format 

graphics is not patented, and due to it also being lossless, PNG files do not have the artifacts 

associated with JPG files.  

 

For SONAR, the primary benefit with PNG files is that they support transparency correctly. 

Rather than a pixel either being transparent or not, PNG icons can support levels of opacity. 

This will allow for more modern-looking track icons in the future, and meanwhile, users can 

more easily take advantage of transparency for smooth blending with colors and backgrounds. 

 

 
 

When creating custom track icons, for best results scale the image size to 96 x 96 pixels. 

 

Also note that you can configure the size of small and large icons in the Cakewalk.ini file. (This is 

located in your user AppData folder. Windows defaults to hiding this folder, so you may need to 

open Folder Options and under the View tab, click Show hidden files, folders, and drives.) By 

default, small icons are 32x32 pixels and large icons are 48x48 pixels. To change the default 

size, use the following INI variables: 

 
[WinCake] 
SmallIconHeight=32 
LargeIconHeight=48 



12 | P a g e  
 

Multiple Clip Export    
Artist, Professional, Platinum 
 

When exporting audio, in addition to exporting specific tracks, buses, outputs, or the entire mix, 

you can now export multiple clips simultaneously. Clip export also exports virtual instrument 

track MIDI clips as audio. Simple instrument tracks automatically export clips to audio; with split 

instrument tracks, you also need to select the synth audio tracks before exporting. 

 

 
 

After selecting the clips you want to export, choose File > Export > Audio. Under Bounce 

Settings, for Source Category choose Clips. You can also choose a file name to precede the clip 

names. For example, if you export three clips named Riff01, Riff02, and Riff03, then choose a 

file name of Guitar Loops, the exported clips will be named Guitar Loops, Riff01.wav, Guitar 

Loops, Riff02.wav, and Guitar Loops, Riff03.wav.  

 

Remember that SONAR can also export and import Broadcast WAV files. Under Preferences > 

File > Audio Data, check Export Broadcast Waves By Default to time-stamp the clip locations on 

the timeline. If you also check Always Import Broadcast Waves At Their Timestamp, then these 

clips will be imported back to their original timeline locations. 
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There’s one caution involved in Broadcast WAV import: Some loop and sample libraries time-

stamp the files at arbitrary times, like 1:00:00 hours. If Always Import Broadcast Waves At 

Their Timestamp is checked, then these will import way down the timeline, so you may not be 

aware they’ve been imported.  
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Clip Export with Extended “Tail”    
Artist, Professional, Platinum 
 

When exporting clips, SONAR traditionally exported only the audio defined within the clip itself. 

For example if there was delay or reverb, either as a track effect or as an effect inserted in a 

clip, the delay or reverb “tail” would stop whenever the clip ended. To include this tail with a 

clip effect, you needed to add enough silence at the clip end to accommodate the tail. With a 

track effect, you needed to add sufficient silence to the clip, render it, and then export.  

 

Starting with Ipswich, none of this is necessary because you can specify a time to accommodate 

a tail when exporting a clip. Simply choose Preferences > Audio Data, and enter the desired Clip 

Tail Duration. There is no practical limitation on how long the tail can be.  
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Fixes and Workflow Enhancements 
Artist, Professional, Platinum 

 

Fixed issues where: 

 

 In some cases adding a user transient marker in Audio Snap could cause other markers 

to stop drawing (disappear) 

 Track icons could become distorted when opening projects 

 Undoing overlapping clips could leave empty lanes 

 Splitting notes using CAL scripts could cause crash 

 Track folder would move to the bottom of view when a track was added to it 

 Step sequencer clips were blank on tracks with Drum Maps 

 Shift-click to extend selection didn’t work in the Track view 

 Adjacent punch recording could unexpectedly create a new lane 

 Dragging audio clips from browser would create an additional lane in the Track Lanes  

 Selected clips could disappear when cropping using auto crossfade 

 Audio Snap was generating superfluous user transients with low level audio material 

 Dotted note drawing in the staff view needed improvement  

 PRV keyboard could be misaligned from note pane when opening after zooming 

 Zoom tool didn’t always revert back to smart tool with press-hold gesture 

 Project bitmaps didn’t display completely when a project was spread across two screens 

 Press - hold hotkeys for tools were not working properly 

 The setting “Allow only one project at a time” in preferences was causing the Start 

Screen to open unexpectedly.   

 Some language characters were not working properly with start screen  

 Clicking on an empty colors box in Preferences - colors resulted in "Parameter is 

incorrect" errors  
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Review: Ploytec PL2 Minature Hardware Synthesizer 
 

By Craig Anderton 

 

And now for something completely different: A 

hardware synthesizer that’s the size of an 

overachieving ice cube, and costs under $100. What’s 

more, it has its own “mad scientist” personality—if you 

like Commodore-64 SID chips, speech synthesizers, 

circuit bending, and rude noises as well as musical 

sounds, this will entertain you for hours. No, it’s not 

about strings, pianos, and Moogy bass lines, but 

SONAR and Rapture Pro already give you plenty of 

those. This is a whole other animal. 

 

There are two PL2 models, the black MIDI one and the 

white USB one (nicknamed the Leukos). The black version has a 5-pin MIDI in, RCA phono audio 

output, and mini-USB jack for power; it’s your basic real-time hardware synth. The Leukos, 

reviewed here, is designed to work with computers and is both Mac and Windows-compatible. 

It hooks into your computer via USB (although it also has a 5-pin DIN connector), and the RCA 

photo output feeds your mixer, audio interface, or powered speaker.  

 

In terms of modules, here’s basically what it has. Note that this cool artwork is not the 

accompanying editing software (Windows, Mac 10.6 and above, and iPad), but it does get 

across the elements in the PL2’s toolkit. 
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TWEAKING THE SOUNDS 

 

Just about every parameter can be controlled via MIDI Continuous Controller messages, so 

while it’s tempting to use a little portable keyboard to control the Leukos, having a controller 

with lots of assignable knobs, buttons, and sliders is a better option. However, the Editor also 

provides the control you need to tweak sounds. 

 

 
 

Furthermore, Ploytec offers free templates for Native Instruments’ Reaktor, Behringer 

BCR2000, Korg nanoKontrol2, Korg taktile 49, Nord Modular G2, Novation Impulse 49/61, 

Roland A300/500/800 pro, Terrasoniq Area61, TouchAble (iOS), TouchOSC (iOS) and Yamaha 

KX25/49/61. Although pre-Windows 10 operating systems weren’t multi-client with MIDI, 

there’s a free downloadable driver that lets you run SONAR and Editor at the same time…very 

thoughtful. You don’t need the driver, but it’s essential if you want to do more than just play 

the synth in real time and tweak it with the editing software. 

 

LIMITATIONS 

 

At this price and given the small size, it’s only reasonable to expect some limitations. The main 

one is it plays only two notes at a time, although you can configure these as two individual 

notes, stacked notes, octaves, or mono. There’s also no filter envelope, the choice of 
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waveforms is limited, there are no onboard controls (so you need to use the editing software or 

an external controller to make it do interesting things), and the PL2 does require a certain 

amount of MIDI literacy. 

 

COOLNESS 

 

In addition to the unique sonic character, a huge plus is that there’s no latency—after all, this is 

truly a hardware synth, and MIDI-over-USB is lightning fast. It’s refreshing to have something 

loaded into a computer where there’s zero delay between what you play and what you hear, 

and although the editor’s internal on-screen keyboard isn’t touch-sensitive, you’ll be glad 

SONAR’s virtual controller is.  

 

My favorite feature is that you can swap firmware via the editor program. Loading version 2.56 

turns the PL2 into a speech synthesizer that’s no Siri, but does let you string together phonemes 

and create all kind of Commodore-64 type verbal nonsense sounds. To me this cries out for a 

loop library, but then again, I’m kind of weird that way. 

 

For more information and lots of audio examples, check out Ploytec’s product landing page and 

the product landing page for the US distributor, Eleven Dimensions Media.  

 

CONCLUSIONS 

 

I definitely want to do a little sampling, because some of the sounds from this Lilliputian box are 

indeed unique. Overall this is a fun synth, doesn’t cost much, doesn’t take up a lot of space, and 

has a high fun factor. Yes, it’s a quirky little instrument…but that’s one of its charms.  

  

http://ploytec.com/pl2/
http://www.11dmedia.com/ploytec-pl2---palm-sized-synthesizer.html
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Anatomy of a SONAR Project: Loop-Based Video Soundtrack 
 

By Craig Anderton 

 

Some people think loops are all about DJs and dance music, but loops have many other uses. 

One of my favorites is putting together a quick soundtrack. This article describes the process, 

and hopefully, will provide some inspiration on one of the many ways to use loops. (Also note 

that putting together soundtracks for presentations, commercials, videos, and the like can 

provide an additional income stream for your studio.) 

 

I recently did five product videos for Neat Microphones. My personal music library provided 

soundtracks for two of them, but nothing was suitable for the other three. Fortunately, I was 

able to create two of the soundtracks using SONAR Platinum and its content; for the other one, 

I still used loops and SONAR, but via Ueberschall’s Elastik player and a couple of their loop 

libraries. 

 

The primary object in this type of project is not to repeat loops endlessly, but to find 

compatible loops that work well together, then alternate them to create something that’s 

similar, but varying. Dominant themes need to re-occur periodically, with occasional surprises 

thrown because paradoxically, having something repeat indefinitely draws attention to itself—

which you don’t want in a soundtrack whose main purpose is solely to support the visuals and 

narration.  

 

The project had four tracks: 1 and 2 for percussion, 3 and 4 for melodic elements. 

 

THE MELODIC HOOKS 

 

First up: finding a pair of loops that can alternate to provide a main theme. In the Browser, at 

this early stage I uncheck “Preview at Host Tempo” to get a sense of the native tempo—I’d 

rather not stretch more than needed. Because the narration was quite fast-paced, any music 

needed to stay out of the way of the message and not be a distraction. So, I started browsing 

Sample Magic’s Minimal Tech-House folder, which is a suitable genre. 
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Overall view of the completed project 

 

mth_syn_125_filterrise_G (chartreuse clips in Track 3) and mth_com_130_vinyl_F_Rex (green 

clips in Track 4) were ideal, especially because they didn’t have to stretch much to conform to 

the 120 BPM tempo. However, mth_syn_125_filterrise_G became too bright in the last two 

measures, so I kept the first two, bounced the clip to itself, and re-“groove-clipped” the first 

two measures to loop them.  

 

With a two-minute video you also need some variations, which required a couple more melodic 

loops. After a little more browsing, mth_mus_127_ubertek_G_Rex (violet clips in Track 3) did 

the job but I couldn’t find anything else in the Minimal Tech-House folder for a break element 

that would appear briefly, then go away. Deep Tech House is a similar genre, and the file 

dth_com_125_amour2_Am_Rex (dark blue clip in Track 4) was ideal. The last melodic element, 

mth_music_130_B_iquifilter_Rex (light blue in Track 3), sounded appropriate for a break 

toward the beginning. 

 

Summing up, the loops in Tracks 3 and 4 provided a combination of consistency, with enough 

other elements added in isolation or layered to provide variations. 

 

I GOT RHYTHM 

  

Next up: finding a background pulse. Here, you don’t want as much variety as the melodic loops 

because the rhythm needs to provide consistency. For this, it’s helpful to find a compatible loop 

and stretch it the entire length of the soundtrack, then start arranging the melodic elements. 

After there’s a good melodic flow, then you can add variations to the percussive tracks. 

 

There are two workhorses here, mth_drlp_127_dan'sgroove_Rex (red clips in Track 1) and 

various tambourine parts from my EDM Percussion Library (orange clips in Track 1). The clips in 

Track 2 add more variety—mth_top_130_swivelclick_Rex (tan), dth_drlp_125_karting1_Rex 
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(yellow), and for a brief bit of drama to lead into the final element, 

dth_drlp_125_africola3_Rex (purple). 

 

EMPHASIS TWEAKS AND TRANSITIONS 

 

When you want to accent something in the visuals, you can interrupt the background flow and 

add short variations. Here are some examples. 

 

 
 

Just before the end when the tagline comes in, the loops in Tracks 1, 3, and 4 have had sections 

cut away. The ends have fades to avoid clicks. Meanwhile, the beginning of the ubertek loop 

has been split and laid out as three repeating beats, with the second one reversed to add more 

variety. After this break, the loops resume. 
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In this section, all the music drops out briefly to prepare for a break midway through the video. 

Copying the first beat from a couple loops, shortening them to 16th notes, then placing them to 

provide an intro to the next section adds some “half-time interest” to the soundtrack. 

 

IT’S A WRAP! 

 

Hopefully this has provided some ideas on how to use loops to create short video soundtracks. 

It’s a balancing act; the soundtrack needs to be interesting, but not so interesting it distracts 

from the video and narration. For product videos you probably don’t want punk or dark trance, 

so you need something upbeat but also fairly minimal. A tempo of 120 BPM seems about 

right—too slow a tempo will put people to sleep, too fast a tempo will make people nervous. 

 

To hear the soundtrack described in this article, check out the video for Neat Microphone’s 

Bumblebee USB mic. However, the videos for the King Bee condenser mic, Worker Bee 

condenser mic, Beecaster USB mic, and Beeline cable also all have soundtracks created in 

SONAR. 

 

 

  

http://www.youtube.com/watch?v=N4Uk1vBf4WA
http://www.youtube.com/watch?v=x_cqonnpya8
http://www.youtube.com/watch?v=xxAj5iRi_WE
http://www.youtube.com/watch?v=2DR_nF9odVg
http://www.youtube.com/watch?v=7gjp2e8UTQ4
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BlogBeat 
 

The Cakewalk blog is loaded with useful and interesting information, so don’t miss out! Here 

are some of the blog’s “greatest hits.” 

 

5 Tools to Get “that Analog Sound” with SONAR. With the advent of digital 

audio, some feel a certain “analog” quality has been lost. But analog 

emulations have come a long way lately, and this blog post from Cakewalk’s 

Joey Adams gives practical points on using some of SONAR’s plugins to add 

that “analog sound.” 

 

Easy Dynamic Vocal FX in SONAR. Sure, we all know about EQ and 

compression. But what about adding dynamic effects to voice? Dan Gonzalez 

explains how to use sidechaining with processors so that effects like delay and 

reverb “get out of the way” when the singer is singing; this can add more 

clarity and definition to the vocal mix. 

 

Ten Nasty Mixing Mistakes. There’s an art to making a great mix—and part of 

that art is avoiding the mistakes that can detract from a great mix. Craig 

Anderton covers ten sure-fire ways to help wreck a mix, from burying the 

vocals, to falling in love with a part just because it’s cool, to not paying 

attention to the crucial details that can make a big difference. 

 

ILan Bluestone Discusses EDM Music Production Techniques. iLan Bluestone is 

one of EDM’s rising stars, and one of the few to have played Madison Square 

Garden. In this video interview with Cakewalk’s Jimmy Landry and Markkus 

Rovito from Electronic Musician magazine, iLan covers some favorite SONAR 

techniques that contribute to his chart-topping EDM tracks.  

 

SONAR for Songwriters. A lot of songwriters will tell you that writing on a 

computer is more cumbersome than just picking up a guitar or heading over to 

a piano, but these practical tips from Craig Anderton show how to streamline 

the songwriting process in SONAR—and maybe even get faster results than 

with conventional songwriting techniques. 

 

 

 

 

  

http://blog.cakewalk.com/5-tools-to-get-that-analog-sound-from-sonar/#more-22495
http://blog.cakewalk.com/easy-dynamic-vocal-fx-sonar/#more-21705
http://blog.cakewalk.com/mixing-mistakes/
http://blog.cakewalk.com/ilan-bluestone-approaches-charting-edm-tracks/
http://blog.cakewalk.com/sonar-for-songwriters-by-craig-anderton/#more-17114
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